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Getting Started with Microsoft
®
 Publisher 

Microsoft Publisher enables you to quickly create professional looking publications 

such as newsletters, booklets and posters even if you have no previous experience of 

desktop publishing.  It and comes with a range of pre-designed templates containing 

images and placeholder text which you then replace with your own or alternatively, you 

can create your own publication from scratch. 

Many of the commands and toolbars in Publisher are similar to other Microsoft Office 

applications, so new users will find text editing familiar.  However, Publisher is much 

more flexible, in that text, graphics and even tables are all independent elements.  It is 

the precise manoeuvring and positioning of these elements that enable complicated 

layouts to be achieved in a professional manner. 

LEARNING OUTCOMES 

After working through this guide you should be able to: 

 Open and modify one of Publisher's many pre-designed templates 

 Create text boxes and columns and fine tune the content 

 Flow text from one text box to another 

 Add pictures and control text wrapping 

 Create an A5 booklet from scratch 

 Create and print a poster 

BEFORE YOU BEGIN 

If you wish to use the services of a professional printer to print your publication, the 

University and College print service "Inprint+Design" (http://www.inprintdesign.com) 

offers a competitive full colour printing service in sizes up to A0.  Please contact them 

to discuss you needs before creating your publication on 01274-235757. 

OPENING PUBLISHER 

To open Microsoft Publisher click on the Start button and choose All Programs, 

Microsoft Office, Microsoft Office Publisher 2007. 

In the opening screen, the 

left hand pane shows the 

different categories of 

Publication Types.   

When one of these is 

selected, the middle pane 

will display thumbnail 

images of ready made 

templates. 

The right-hand pane will 

show any previously used 

publications. 

http://www.inprintdesign.com/
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CREATING A PUBLICATION USING A PREDESIGNED TEMPLATE 

1. In the Publication Types pane select a category—eg to create a bulletin choose the 

Newsletters option. 

2. Scroll up and down the thumbnail examples in the central pane and then click an 

appropriate one.  

 

3. Observe the larger preview at the top of the right-hand pane. 

4. If you want to change the current colour or font, under Customize, click the Color 

scheme: or Font scheme: arrows and choose alternatives from the lists.   

5. Click on the Create button in the bottom right-hand corner to launch the template. 

You can now replace the placeholder text and images with your own information. 

Note:  if at any time you decide you don't like your chosen design, or want to change 

the colours or font, you can easily change the template while keeping any 

modified content intact. 

IMPORTANT:  Before you start modifying the design, save the file and remember to 

save it regularly while working on it. 
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WORKING ON THE PUBLICATION 

 

Note the Objects toolbar down the left-hand side of the window.  This contains tools to 

insert text boxes, tables, and graphics, as well as specific drawing tools.  (Hover the 

mouse over each tool to reveal a tool tip.) 

Next to the object toolbar is the Task Pane, currently displaying the Format Publication 

options—from here you can alter the Colour and Font Schemes, load a different 

template, or change the page size. 

MOVING BETWEEN PAGES 

At the bottom of the screen are the Page Sorter icons.  Click on 

these to move to other pages in the document. 

DELETING OR ADDING PAGES 

To delete a page, right-click on the relevent Page Sorter icon and select Delete Page. 

To add pages, right-click a Page sorter icon and select Insert Page. 
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TEXT BOXES 

Replacing Existing Placeholder Text 

1. If necessary, click the arrow in the Zoom box on the standard 

toolbar, and increase the magnification level in order to see the 

content more clearly.   

Use the scroll bars to position the document in the window. 

2. Click the placeholder text and press the DELETE key.  

3. Now click in the empty text box and start typing your text.  (Options to change the 

font, adjust character or paragraph spacing, add bullets or insert a dropped cap are 

available from the Format menu.) 

Note:  When selected, some text boxes 

may display a "Go the Next Text 

Box" button.  This tells you that the 

text boxes have been "connected" 

and that any overflow text flows 

into the next connected box. 

(See the section on: "Linked Text 

Boxes" for further information.) 

Deleting a Text Box or other Object 

1. Position the mouse on the edge of the item.  (A 

tool tip will reveal the selected item.) 

2. Click the item to select it. 

3. Right click and choose Delete Text or Delete 

Object from the sub-menu. 

Creating a New Text Box 

1. Click the Text Box tool    on the Objects toolbar. 

2. Position the cross-haired    cursor; hold down the left mouse button, and drag to 

create a rectangle. 

Resizing a Text Box 

If the text box is not large enough to take all the text, a "Text in Overflow" indicator is 

displayed when the box is selected. 

1. To rectify this, rest the mouse over 

one of the text box handles; when a 

double-headed arrow appears, click 

and drag to enlarge the box. 

Once the text box can accommodate 

all the text, the Text in Overflow indicator will disappear. 

Alternatively, to make a text box smaller, drag the selection handles inwards. 

Text in overflow 
indicator 
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Moving a Text Box 

1. To reposition a text box, click inside to select it, and then move the mouse slowly 

towards the edge of the frame. 

2. When it changes into a four-headed arrow, hold down the 

left mouse button and drag the whole object to the desired 

position.  (See also: Aligning Objects.) 

Changing the Appearance of a Text Box 

For added impact, you can apply colourful borders and/or a background, rotate the 

text, or change the text box margins.  First select the Text Box, and from the Format 

menu, select Text Box. 

To add a border Select the Colors and Line tab. In the Line section, click the 

Color: arrow and choose from the list, or click More Colors to 

view the complete range. 

Select options under Dashed: Style: and Weight: and then 

observe the result in the Preview box. 

To add a 

background 

Select the Colours and Line tab. In the Fill section, click the 

Color: arrow and choose from the list, or click More Colors to 

view the complete range. 

To rotate text 

inside a text box 

Select the Text Box tab. In the Text Autofitting section, select 

Rotate text within AutoShape by 90°.  

Alternatively, hold down the mouse on the green selection 

handle and drag to rotate the complete object. 

To adjust the 

text box margins 

Select the Text Box tab. In the Text Box Margins section, type in 

new values in the Top, Bottom, Right and Left boxes. 

Linked Text Boxes 

When a text box contains more text than it can display, the Text in Overflow indicator 

appears at the bottom of the box. 

Instead of increasing the text box size, hidden text can be forced to continue in another 

part of the publication, eg in the next column or on the next page.  This is done by 

creating another text box, and then "connecting" the two. 

1. Create another text box at the desired position, and then click in the text box which 

holds the first part of the text. 

2. On the Connect Text Boxes toolbar, click on the 

Create Text Box Link button. 

(If this is not displayed, click on View, Toolbars, 

Connect Text Boxes.) 

The cursor will now change to a pitcher shape when moved over 

the empty text box.  (If the new text frame is on another page, first 

click the relevant Page Sorter icon at the foot of the page. 
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3. Click in the new text frame to fill with the overflowed text. 

When you select a text box which is 

linked to another, it will display a Go to 

Next Text Box indicator at the bottom 

right-hand corner. 

4. To move to the next connected box, 

click on the arrow. 

Similarly, the upper left-hand corner 

will display a "Go to Previous Text Box" indicator to enable you to move to the 

previous connected text box. 

Adding a Continued Notice to a Text Box 

You can add a "continued on" or "continued from" notice to help guide the reader 

through text boxes on different pages. 

1. Select the text box, then click on the Format menu and select Text Box. 

2. Select the Text Box tab and then click on the Include "Continued on page…" or 

Include "Continued from page…" options as appropriate. 

3. Click on OK. 

WORKING WITH COLUMNS 

In order to work with columns, you can either create text frames to fit columns defined 

by layout guides, or set up multiple columns in a single text frame. 

Multiple Text Frames 

1. To add layout guides click on Arrange, Layout Guides, Grid Guides.  Under 

Column Guides, select the desired number of columns. 

2. Now create text boxes to fit the columns.   

Note:  In these columns, text does not automatically flow from one column to the next 

unless you "link" the text boxes.  See the section: "Linked Text Boxes" for 

instructions on how to set this up. 

Single Text Box Divided into Columns 

To divide a text box into columns, first select 

the text box, then click the Format menu and 

select Text Box. 

1. Select the Text Box tab and then click on 

the Columns button. 

2. Enter the number of columns and if 

necessary adjust the spacing 

measurements. 

3. Click on OK to return to the publication. 
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GRAPHICS 

Inserting a Picture from File 

You can use this method to insert a graphic previously saved in a file. 

1. On the Objects toolbar, click on the Picture Frame tool.     

2. From the sub-menu, choose Picture from File. 

3. In your publication, drag the mouse to create a frame to hold the picture.  When the 

mouse is released, the Insert Picture dialog box will be displayed. 

4. Navigate to the correct folder, select the file and then click on Insert. 

Inserting Clip Art 

1. On the Objects toolbar, click on the Picture Frame tool.     

2. From the sub-menu select Clip Art.  This will open 

the Clip Art task pane. 

3. In the Search for: box, enter a word that describes 

the required picture.  (To restrict your search to 

specific collections, or to state what the results 

should be, click the arrows in the Search in: 

section and select or de-select the options as 

appropriate.) 

4. Click on Go. 

5. When the results of the search are fully displayed, clip on the desired picture to 

insert it in your publication. 

Replacing an Existing Image or Object 

1. If you simply want to replace a placeholder picture with one of your own, right-click 

the picture and choose the Change Picture command. 

Note:  if the picture has been grouped with another object, eg a caption, you may need 

to "ungroup" it first.  (See the section on "Grouping Objects".) 

2. If you have a saved image file, select From File and navigate to the directory to 

select it. 

Alternatively, you can select the Clip Art option and search for a relevant picture in 

the Clip Art Task pane. 

Precise Resizing and Positioning of an Object 

1. To change the exact size and position of an object, right-click on it and then choose 

the Format . . . option from the sub-menu. 

2. Choose the Size tab and enter exact dimensions to resize, scale or rotate the 

object.  (If you select the Lock aspect ration box, this will keep the Height and 

Width settings in the same proportion.) 

3. Choose the Layout tab to position the object precisely on the page, by entering 

specific measurements in the Horizontal and Vertical boxes.  (Click on the From: 

box arrows to select the part of the page from which the Horizontal and Vertical 

settings are calculated.) 
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Wrapping Text around an Object 

When a picture is placed on top of text, 

the text can be made to wrap around the 

contours rather than the frame of the 

picture as shown in the example opposite. 

 

1. Click on the image to select it—this 

displays the picture toolbar. 

 

2. Click on the Text Wrapping button 

and choose one of the following 

options: 

Square: this wraps the text around 

the image's frame. 

Tight: will wrap the text around the 

actual image. 

Top and Bottom: the text appears at 

the top and bottom of the image only. 

Through: this wraps the text around the perimeter and inside any open areas. 

None: the picture is completely ignored by the text. 

3. Notice the Edit Wrap Points button at the foot of the text wrapping options.  This 

places small black handles along the picture outline. 

When the mouse is positioned on a handle, you can 

then drag the boundary inwards or outwards to 

control the text wrapping even more. 

 

Note:  To add more handles to the boundary, hold down 

the CTRL key while clicking on the outline.  To 

delete handles, hold down SHIFT+CTRL and click an existing handle. 

Grouping Objects 

Objects which need to be kept together can be "grouped" so they 

become one unit. 

1. Hold down the SHIFT key and select each item to be included 

in the group.   

2. Click on the Group Objects icon    in the lower right-hand 

corner of the selection.   

To remove a "group" click in the group so it is selected, click Ungroup Objects 

icon and then click outside the selection. 
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CREATING A PUBLICATION FROM SCRATCH 

Instead of using one of Publisher's pre-designed templates, you can start with a blank 

publication and design the layout as you please.  The following instructions describe 

how to set up an A5 double-sided booklet. 

1. In the Publication Types pane, select Blank Page Sizes. 

2. Under Blank Page Sizes, select the Booklets option, and then click on: 

½ A4 Booklet 14.8 x 21cm. 

 

 

3. Observe the preview at the top of the right-hand pane, and then click on Create. 

4. When asked if you want to automatically insert pages, answer Yes. 

Important Note 

Working with Publisher can be very absorbing, but you should remember to give 

yourself regular short breaks in order to avoid eyestrain and upper limb disorders.  Get 

into the habit of saving your work frequently and while this is happening, stand up, 

stretch and focus the eyes on distant objects. 

As the Format Publication task pane is not required at the moment, click on its Close 

button. 
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Objects 
toolbar 

Margin 
guides 

Page sorter icons 
with current page 
highlighted 

MARGINS 

Observe the "non-printable" blue margin guides; these appear on every page and 

determine the working area.  The content of the publication is placed within these 

guides to ensure a consistent layout.  If required, the guides can be changed, and 

additional ones displayed to form a grid. 

Note:  Before beginning a publication it may help to sketch a rough copy of the layout 

on paper - this will help you to plan where to place the layout guides. 

INCREASING OR DECREASING THE WORKING AREA 

1. Click on Arrange on the menu bar, and 

then choose Layout Guides. 

2. On the Margin Guides tab, enter new 

measurements. 

3. If the publication is going to contain 

columns, click on the Grid Guides tab 

and add the appropriate number of 

columns under Column Guides. 

4. Click on OK. 

Remember, these guides do not print - they are for layout purposes only. 

WORKING ON DIFFERENT PAGES 

To move between pages in the publication, click the relevant page number on the page 

sorter icons.  To insert an extra page at any time, click on the Insert menu and choose 

Page.  Enter the number of pages and specify where they should be positioned.  To 

delete a page, right-click the relevant page sorter icon and choose Delete page. 
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CREATING THE OBJECTS 

Everything in a Publisher document is an individual element, whether it is a block of 

text, a graphic, or a table.  These elements are inserted into a publication using the 

Objects toolbar at the left-hand side of the screen. 

 

Click the relevant button on the toolbar, position 

the cursor in the document, and with the left-

mouse button held down, drag diagonally to 

create the object. 

When the mouse is released, the object will then 

be inserted, surrounded by re-sizing handles. 

Some objects present you with further options, eg 

the Table object will display a "Create Table" 

dialog box, asking you to specify the number of 

columns and rows.   

For more specific information on inserting and 

manipulating text boxes and graphics, see the 

earlier sections: "Text Boxes" and "Graphics".  

 

 

FINE TUNING A PUBLICATION 

ALIGNING OBJECTS 

While the move option is useful for repositioning items, the aligning technique arranges 

objects in line with each other, or with the margins. 

1. Click the first object, and then hold down the 

SHIFT key while clicking the second one. 

Both objects now become interconnected. 

 

 

2. On the menu bar, click on Arrange, followed by Align or Distribute. 

3. To centre the selected objects horizontally with 

each other, click on Align Center. 

Note:  You can also align selected objects relative to 

the margin by first clicking on Relative to 

Margin Guides, and then choosing another 

option from the menu. 
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NUDGING OBJECTS 

To move an object into an exact position (ie one pixel at a time), click the edge of the 

object to select it, and then press the keyboard arrow keys. 

USING THE RULER GUIDES 

In addition to the margin guides, movable horizontal and vertical ruler guides can be 

displayed to help align objects against each other.  Ruler guides are displayed in 

green, do not print and can be dragged across a page into any position. 

1. In order to use the guides, the vertical and horizontal rulers must be displayed.  If 

these are not, click on View and then on Rulers. 

2. To create a vertical guide, position the mouse pointer 

over the vertical ruler and wait until it changes into a 

double arrow. 

 

 

3. Hold down the left 

mouse button and drag 

into the publication. 

 

4. To remove a ruler guide, 

right click on it and 

select Delete Guide 

from the pop-up menu. 

(To remove all ruler 

guides, click on 

Arrange, Ruler Guides 

and then select Clear 

All Ruler Guides.) 

 

USING THE DESIGN GALLERY 

Publisher has a number of ready designed objects that you can add to your 

publication.   

1. Click on the Design Gallery Object    on the toolbar. 

2. Scroll through the list of designs, click an appropriate one, and then click on Insert 

Object to transfer it into your publication. 

Vertical ruler line 

To move a 
ruler guide, 
hold down 
the SHIFT 
key while 
dragging with 
the mouse. 
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CREATING A POSTER FROM SCRATCH 

The IT Services central printer can print on the following paper: 

A4 (297 mm x 210 mm) (11.69" x 8.27") 

A3 (420 mm x 297 mm) (16.54" x 11.69") 

If a publication is larger than these sizes, Publisher will "tile print" the document, ie it 

will be printed on multiple sheets of paper.  The edges of the sheets can then be 

trimmed and the publication taped together. 

 

1. In the Publication Types pane, click on Blank Page Sizes. 

2. Under Blank Page Sizes, click on Posters. 

3. Click on a suitable size or scroll down the list and choose Create Custom Page 

Size to set up your own measurements. 

4. Observe the preview in the top right-hand corner and then click Create. 

A blank sheet of paper with your specified dimensions will be displayed in the 

window.  If at any time you decide to change the paper size, in the Format 

Publication Task pane, click on Change Paper Size. 

5. You can now add text and images to the poster using the buttons on the toolbar to 

create the objects.   Remember to save the file regularly! 

For more specific information on inserting and manipulating text boxes and 

graphics, see the earlier sections: "Text Boxes" and "Graphics". 
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SETTING UP THE PRINTER TO PRINT A POSTER 

1. Click on File, 

Print Setup. 

2. In the Print Setup box, 

ensure you select the 

correct: 

Printer, 

Paper Size, and 

Orientation. 

3. Now click on the Print 

Preview button in the 

lower-left corner. 

4. Observe the example in 

the Preview window to see how many pages the poster will print on, and if 

necessary, change the Orientation and/or Paper size to reduce the number of 

pages required. 

5. Click on OK. 

PRINTING A PUBLICATION 

The following instructions explain how to print to the Computer Centre's central printer. 

Before printing your publication always preview it.  This is particularly important when 

printing documents such as banners and posters, which require multiple sheets, as it 

gives a true representation of how the document will be printed. 

1. Click on the File menu and select Print. 

2. Under Printer Name, select Central_Printer. 

Note:  if you are printing an A5 booklet, under 2-sided printing options, select: Two-

sided, flip short side. 

3. Click the Print Preview button in the lower-left corner for a final check.   

4. If necessary, make any changes, and then click on Print. 

REPRINTING PART OF A LARGE PUBLICATION 

In a publication made up of numerous sheets of paper, eg a poster, you can print a 

specific part rather than printing the whole document again.   

1. In the Print dialog box, click on Print Preview and determine the row and column 

location of the "tile" you want to reprint. 

2. Under More print options in the Print dialog box, click on Print a Single Tile, and 

then enter the correct Row: and Column: number. 

3. Now click on Print to print the specified tile. 
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